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4 Communications Regulation Information

Communications Regulation Information

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. See instructions if interference to radio or television reception is 
suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with 
radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no guarantee that interference will not 
occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct the interference 
by using one or more of the following measures: 

m Turn the television or radio antenna until the interference stops. 

m Move the computer to one side or the other of the television or radio. 

m Move the computer farther away from the television or radio. 

m Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make 
certain the computer and the television or radio are on circuits controlled by different circuit breakers or 
fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that 
came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions.

Important  Changes or modifications to this product not authorized by Apple Computer, Inc., could void the 
FCC certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices 
and Apple shielded cables and connectors between system components. It is important that you use Apple 
peripheral devices and shielded cables and connectors between system components to reduce the possibility of 
causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple 
peripheral devices, contact the manufacturer or dealer for assistance. 

Industry Canada Statement

This Class B device meets all requirements of the Canadian interference-causing equipment regulations.

Cet appareil numérique de la Classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.
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C H A P T E R

1
1 Setting Up

Your Monitor’s Features
m 21-inch (19.8-inch viewable image size) Sony Trinitron® CRT

m Super fine 0.25/0.27 mm variable aperture grille

m Intelligent software control of all screen functions

m Internal color calibration system

m Multiscan capability: horizontal scan rate of 31.5–106 kHz 

m Support for resolutions up to 1600 x 1200 pixels

m Includes four USB ports for high-speed USB devices

m Anti-reflection, anti-static screen coating

m Support for VESA DDC 2B

m Meets strict TCO’99 standards for ergonomics, energy efficiency, emissions, and ecology

m MPR II, ISO 9241 and EPA ENERGY STAR compliant 

Read this booklet to learn how to set up and connect your Studio Display (21-inch CRT) to 
your computer. This booklet also contains important safety information and troubleshooting 
tips.

Getting Ready to Set Up

Before you unpack your monitor, choose an appropriate location for it. Here are some key 
factors to consider when determining where to place your monitor:

m Be sure that the desk or table can support the monitor’s weight—77 pounds (35 kg).

m Make sure that the monitor cable reaches your computer. The cable should be 
unobstructed when you swivel and tilt the display.
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m Make sure at least one end of the power cord is within easy reach so that you can unplug 
the display when you need to. 

Before you connect your monitor, read the following section to determine if you need any 
additional items. 

Do You Need a Graphics Card?

Your monitor works with any Mac OS–based computer with a PowerPC™ processor and a 
built-in USB port and either a built-in monitor port adapter or a compatible graphics card.

If you’re not sure whether your computer or graphics card will work with the monitor, check 
whether its video circuitry operates within these ranges:

m Horizontal scan rate of 31.5–106 kilohertz

m Vertical refresh rate of 48–120 hertz

Important  Your monitor weighs approximately 77 lbs. To move the monitor, lift it by 
placing your fingers in the recessed areas on the bottom of the monitor. It’s recommended 
that two people lift the monitor together. (See the following illustration.) Do not use the 
stand for moving or carrying the monitor. 

Recessed areas
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Your monitor supports the resolution ranges listed in the following table: 

If no image appears on your monitor after you have completed the instructions in this 
booklet, your computer or graphics card may not be compatible with your display. (Some 
third-party PCI cards are not fully compatible with your monitor.) An Apple-authorized dealer 
can help you select a compatible graphics card.

Your monitor is preadjusted at common resolution and vertical refresh rate settings. For a 
complete list of the preset resolutions, see “Factory-Adjusted Video Modes” in the online 
documentation, About Your Studio Display. For details about accessing the online help, see 
“Getting Online Help for Your Studio Display” on page 17. If you don’t use a preadjusted 
resolution, you’ll need to adjust the screen geometry in the Monitors & Sound control panel. 

Using More Than One Monitor

If your computer has expansion slots, you can connect multiple monitors (including this 
monitor) to your computer. You may need to install a graphics card for each additional 
monitor you are using. See the documentation that came with your computer for 
information on working with more than one monitor.

Resolution Vertical Refresh Rate1 (Hertz)

640 x 480 60–85

800 x 600 60–85

832 x 624 75

1024 x 768 60–85

1152 x 870 75

1280 x 1024 60–85

1600 x 1200 60–85

1 These are ranges only; the actual resolutions and vertical refresh rates that are available to you depend on your computer or 
graphics card. See the manual that came with your computer or graphics card for more information.
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Connecting the Display to Your Computer

1 Plug the socket end of the monitor power cord to the power cord receptacle on the back of 
the display.

2 Plug the other end of the power jumper cord (which plugs into the power socket on other 
equipment) into the power socket on the back of your computer.

Note: If you have a power wall cord, plug the power cord into a grounded wall outlet or 
power strip.

Warning  This equipment is intended to be electrically grounded. Make sure that the 
computer you are connecting your monitor to is grounded. If you use a power cord with a 
three-wire grounding plug, be sure to plug it into a grounded outlet. If you can’t insert the 
plug into the outlet, contact a licensed electrician to replace it with a properly grounded 
outlet. Do not defeat the purpose of the grounding plug!

Important  Before you connect any cords or cables, make sure that your computer is turned 
off and unplugged.

Power cord
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3 Plug the monitor connector on the monitor cable into the monitor port (marked by ™) on 
the back of your computer.

If your computer has more than one monitor port, see the documentation that came with 
your computer for information on choosing the correct port.

If you installed a graphics card in your computer, connect the monitor connector to the 
graphics card’s port instead. For information about installing graphics cards, see the 
documentation that came with your computer or graphics card.

Other video connectors, such as PowerBook adapters, can also connect to your monitor port 
with special adapters. For more information, see the documentation that came with your 
computer.

4 Tighten the thumbscrews on the connection.

You can prevent bad connections and accidental damage by tightening the thumbscrews. Do 
not overtighten the thumbscrews; you might strip the threads.

5 Plug the USB connector on the USB cable into a USB port on the back of your computer.

Make sure the USB connector is attached firmly.

Monitor port icon

Monitor connector

Monitor connector

USB connector

Important  The USB connector is not optional; it’s needed for your computer to work 
correctly with your monitor. If the connector is not connected properly, the software 
controls will not be available.
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6 Connect your USB mouse, keyboard, modem, or other USB peripheral devices to the USB 
ports on the right side of your monitor.

Turning the Display On 

To turn on the monitor for the first time:

1 Plug your computer’s power cord into a power outlet and start up your computer.

2 Press the power button on the front-right side of the display. 

The monitor’s green power indicator light goes on. (It may turn amber if your computer has 
not started up yet.) If the green light does not go on, press the monitor’s power button 
again. If this doesn’t work, shut down and unplug your computer and make sure you’ve 
connected the monitor to your computer properly (see “Connecting the Display to Your 
Computer” on page 10).

USB ports (4)

Power button
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Installing the Apple Displays Software

This section explains how to install the Apple Displays Software on your Mac OS–based 
computer. 

You need the following to be able to install and use the Apple Displays Software:

m a Mac OS–based computer with a PowerPC processor and a built-in USB port 

m Mac OS 8 or later

If you do not have Mac OS 8 or later, you can purchase the software from an 
Apple-authorized dealer or service provider. 

To install the Apple Displays Software, follow these steps:

1 Insert the CD-ROM disc that came with your monitor into the computer’s CD-ROM drive.

The CD-ROM disc icon appears on the desktop. 

2 Double-click the CD-ROM disc icon.

The Apple Displays Software window opens.

3 Double-click the folder labeled with the language you want the software to use.

4 Double-click the Apple Displays Software folder.

5 Double-click the Apple Displays Software Read Me file and read the document that appears.

The Read Me file contains important information about the files included with your software.

6 Choose Quit from the File menu when you’re finished reading.

7 Double-click the Upgrader icon to start the Installer program.

A Welcome screen appears and then the Install Apple Displays Software dialog box appears.

8 Make sure the destination disk named is the startup disk of your computer. If it isn’t, choose 
the name of your startup disk from the Destination Disk pop-up menu.

9 Click Select.

The software license agreement dialog box appears. 

Click Continue, then click Agree once you’ve read and agreed to the terms in the license 
agreement.

10 Click Start.

Important  Make sure you use the Installer to install the software. Do not install the 
software by dragging files to your hard disk. If you do, the software will not work.

Important  Be sure you’re acting within the terms of the software license agreement before 
you agree to install this software on your computer. The license agreement specifies how 
many copies of the program you can make for yourself and others.
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The Upgrader takes a few moments to calculate what needs to be done and then begins to 
copy files. If other applications are open, a message asks you to quit them. Click Continue to 
quit the applications and continue with the installation.

11 Follow the instructions on the screen until the installation is complete.

After the installation, the Upgrader tells you to restart your computer.

12 Click Restart.

The software is now installed and the monitor is ready for use. To adjust the monitor settings, 
use the Monitors & Sound control panel, available in the Control Panels folder in the Apple 
() menu. You can also open the Monitors & Sound control panel by pressing the control 
panel launcher button on the left-front of your monitor. 

Using Manual Controls

You can adjust the picture on your monitor by using the buttons on the front and the front 
underside of your monitor.

Important  If you ever reinstall system software on your computer, you must also reinstall 
the Apple Displays Software.

Important  After you install the software, use the Monitors & Sound control panel to 
optimize your display setup. The Color and Geometry controls allow you to compensate for 
differences in your surroundings and display placement. For example, you can use the 
Geometry controls, such as Pincushion and Beam Landing, to adjust the edges of your screen 
image or minimize color patches on your screen. You can also calibrate your monitor to 
accommodate ambient light or select a preferred gamma and white point. For more 
information, see Mac OS Help (Mac OS 8.5 users) or Monitors & Sound Help, available when 
the Monitors & Sound control panel is active (Mac OS 8 or 8.1 users). 

Power button

Contrast decrease button 

Contrast increase button 

Control panel launcher button 

Brightness decrease button

Brightness increase button
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The following table describes the function of each control.

Safety Instructions

For your own safety and that of your equipment, always take the following precautions.

Disconnect the power plug (by pulling the plug, not the cord) if any of the following 
conditions exists:

m The power cord or plug becomes frayed or otherwise damaged

m You spill something into the case

m Your display is exposed to rain or any other excess moisture

m Your display has been dropped or the case has been otherwise damaged

m You suspect that your display needs service or repair

m You want to clean the case or screen 

Control Function

Power button Use this button to turn the monitor on or off. A green light indicates the 
monitor is on. An amber light indicates the power-saving mode (sleep). 
When the monitor is in sleep, move your mouse or press a key to return 
the monitor to its normal display operation. 

Contrast controls Use these buttons to increase or decrease the contrast of the picture.

Brightness controls Use these buttons to increase or decrease the brightness of the picture.

Control panel launcher 
button

Use this button to open the Monitors & Sound control panel window.

Warning  Do not clean any part of your display with a cleaner that contains alcohol or 
acetone, and never spray cleaner directly onto the screen. For more information about 
cleaning your display, see the online documentation for your display.

Important  The only way to disconnect power completely is to unplug the power cord from 
the main power supply. 
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Be sure that you always follow these instructions:

m Keep your display away from sources of liquids and moisture.

m Don’t set anything on top of the display.

m Keep the display’s vents free from obstruction.

m Read all the setup instructions carefully before you plug your display into a power source.

Warning  Never remove the case from the monitor! You could come in contact with 
hazardous voltage. Electrical equipment may be hazardous if misused. Operation of this 
product, or similar products, must always be supervised by an adult. Do not allow children 
access to the interior of any electrical product and do not permit them to handle any 
cables.
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2
2 Troubleshooting

Read this section for solutions to common display problems. For problems related to the 
computer, see the documentation that came with your computer.

Note: If you have a problem with your monitor and nothing presented in this booklet solves 
it, consult the service and support information that came with your monitor for instructions 
on how to contact an Apple-authorized service provider or Apple for assistance.

Getting Online Help for Your Studio Display

If you have Mac OS 8.5 installed on your computer, you can get online help using your 
display by opening the Help menu and choosing Help Center, then selecting About Your 
Studio Display. If you have Mac OS 8 or 8.1, you can access the online help by double-clicking 
the Studio Display icon on your desktop.

The Power Indicator Light Doesn’t Come On
m Make sure the monitor is turned on.

m Make sure the computer is turned on.

The monitor’s power indicator light won’t turn green unless your computer is on.

m Make sure an energy saver program isn’t active on the computer.

Warning  If you attempt to repair the monitor yourself, any damage you cause to the 
monitor will not be covered by the limited warranty on your monitor. Contact an 
Apple-authorized dealer or service provider for additional information about this or any 
other warranty question.

Important  For solving problems related to the software, use the Monitors & Sound control 
panel. For help using the Monitors & Sound control panel, open the Help menu and choose 
Show Balloons.
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The monitor’s power indicator light turns amber when an energy saver program is on 
(when the computer is in sleep). Also, it may take a few moments for the computer to 
wake up from sleep.

m Make sure the power cord is plugged in properly.

If the monitor power cord is plugged into your computer, make sure your computer is 
turned on and the cord is firmly plugged in.

If the monitor power cord is plugged into a grounded wall outlet, make sure the cord is 
firmly plugged in. Check to see whether power to the outlet has been interrupted. You 
can test the outlet by plugging in something that you know works—like a desk lamp or 
radio. If the test appliance works, but the monitor doesn’t, contact an Apple-authorized 
dealer or service provider.

m Make sure the monitor cable is connected to your computer properly.

m Make sure the thumbscrews on the monitor cable are tightened securely.

The Screen Image Is Dim, Flickers, or Does Not Appear

First try these basic checks:

m Make sure that the power cord is plugged in properly.

If the monitor power cord is plugged into your computer, make sure your computer is on 
and the computer’s power cord is firmly plugged into the computer and an electrical 
outlet or power strip. If you are using a power strip, make sure it is turned on.

m Make sure the monitor cable is properly connected to your computer monitor port or 
graphics card.

m Make sure the thumbscrews on the monitor connector are tightened securely into the 
monitor port.

m Make sure that your computer and monitor are turned on.

If you still have problems, look for your problem on the following pages and follow the 
instructions.

No image appears on the screen, or the screen is dim, and the monitor’s power 
indicator light is on.

m The monitor may have gone to sleep, or a screen saver that darkens your screen may be 
activated. Move the mouse or press a key to restore the image.

m Make sure the brightness (¤) and contrast (O) controls are set correctly. The brightness 
and contrast controls are located on the front underside of the monitor.

m If the monitor cable is properly connected and the amber light is on, the monitor may not 
be compatible with your computer or graphics card. You may need to install a different 
graphics card in your computer or use an adapter. See “Do You Need a Graphics Card?” 
on page 8.
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The screen flickers.

m The flickering could be caused by interference from a nearby power line, a fluorescent 
light, or an electrical device—for example, a radio, a microwave oven, or other computer 
equipment. Try relocating nearby electrical devices, or moving your computer and 
monitor.

m If you have more than one monitor attached to your computer, the monitors might be 
interfering with one another. Move the monitors farther apart or set the monitors at an 
angle, so their screens are close and their back panels are farther apart. If you still see 
flickering after moving the monitors more than 16 inches apart, contact an 
Apple-authorized dealer or service provider.

m Your monitor may flicker if you have chosen a resolution with a refresh rate of 60 hertz or 
below. You may be able to change to a resolution with a higher refresh rate using the 
Monitors & Sound control panel.

Contrast (O) and brightness (¤) controls on the front of the monitor don’t 
appear to work.

Your monitor may have the contrast (O) and brightness (¤) controls disabled. Click the 
Color button in the Monitors & Sound control panel and select Preferences. Under 
Calibration Protection, make sure that the checkbox for disabling contrast and brightness 
controls is not selected; then, click OK.

There are one or two very thin gray lines across the screen, one near the top 
and the other near the bottom.

This is a normal characteristic of the Sony Trinitron color picture tube design. The lines do 
not appear in any documents you print.

Problems With the Energy-Saving (Sleep) Mode

Some computers and graphics cards do not support the Energy Saver feature. See the 
documentation that came with your computer and graphics card for more information.

Problems With Picture Quality or Placement

No colors appear on the screen, or the colors don’t look right.

m Make sure that the number of colors is set correctly in the Monitors & Sound control 
panel or in the Control Strip. For more information, see the online help for your display.

m If you have already changed the number of colors displayed on the screen, try one of the 
following:

m Quit the application you’re using and start it again.

m Go back to the number of colors you were using previously.
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The screen has color patches and video jitters.

m Adjust the Beam Landing control using the Geometry section of the Monitors & Sound 
control panel. 

m Move your display away from any external magnetic fields such as other monitors, video 
systems, printers, scanners, fluorescent lights, metal cabinets or desks, and electric clocks 
and unshielded speakers. The external fields may interfere with or disrupt the monitor’s 
internal field, causing the screen image to jitter, distort, drift, or lose color quality.

The screen image is off-center.

m Adjust the vertical or horizontal position of the screen image using the Geometry section 
of the Monitors & Sound control panel. Press the Control panel launcher button to open 
the Monitors & Sound control panel. (Keep in mind that you may have to adjust the 
picture again if you change resolutions.)

m Try using one of the preset resolutions listed in “Factory-Adjusted Video Modes” in the 
online documentation for your display.

m Try changing to another resolution using the Monitors & Sound control panel or the 
Control Strip (for help, see the online documentation for your display).

The screen image is too large or too small.

m Try changing to another resolution using the Monitors & Sound control panel or the 
Control Strip.

m Adjust the horizontal or vertical size of the picture using the Geometry section of the 
Monitors & Sound control panel. (Keep in mind that you may have to adjust the picture 
again if you change resolutions.)

m Make sure Overscan is turned off in the Geometry section of the Monitors & Sound 
control panel.

The colors on your screen appear too blue, too yellow, or too red.

Adjust the color settings, recalibrate the monitor, set a new white point, or reset the monitor 
to the default factory color settings. Use the Color section of the Monitors & Sound control 
panel to adjust color settings.

The screen appears greenish, the screen image is unreadable, or there is 
“snow” on the screen.

Make sure the monitor cable is connected firmly to the monitor port or graphics card on the 
back of the computer.

There are wavy lines on the screen, creating an optical effect or moiré pattern.

You may see a moiré pattern while in some resolutions, depending on the desktop pattern 
displayed on the screen (a black-and-white checkerboard pattern frequently causes moiré). 
Change to another resolution using the Monitors & Sound control panel or the Control Strip. 
For help changing the desktop pattern, see Mac OS Help or Help.
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Problems With Changing the Resolution

After you change the screen resolution, a window is partly off the screen or 
missing, or you can’t see the whole screen.

If a window is missing:

m Quit the application whose window is missing and then open it again.

m Go back to the resolution you were using, close the window, change the resolution, and 
then reopen the window.

If you cannot see the whole screen:

m Adjust the vertical or horizontal position of the screen image using the Geometry section 
of the Monitors & Sound control panel.

m Turn off Overscan.

m Try one of the preset resolutions.

If you have problems with a particular application, contact the developer of that application. 

After you change the screen resolution, icons move.

Changing the screen resolution affects how information can be displayed on your screen. 
The Finder may automatically reposition icons after you change the screen resolution.

When you select a different resolution, the monitor goes blank, and the 
resolution does not change.

Your monitor may go blank for 10 seconds if you select a resolution that does not work with 
your monitor. Try selecting another resolution.

Problems Finding the Control Strip

You may have hidden the Control Strip. Open the Control Strip control panel and click the 
button labeled “Show Control Strip.”

Problems With the Monitors & Sound Control Panel

The Monitors & Sound control panel opens, but does not include specific 
controls for adjusting color or screen geometry. 

m Make sure the USB connector on the monitor cable is plugged directly into a USB port on 
your computer.

m Reinstall the Apple Displays Software that came with your monitor.
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The name of your monitor doesn’t appear in the Monitors & Sound control 
panel.

m Make sure that the monitor cable is plugged into your computer or an electrical outlet, 
then restart.

m Make sure the USB connector on the USB cable is plugged directly into your computer’s 
USB port or a powered USB hub, such as another monitor’s USB port.

m Make sure you’ve installed the Apple Displays Software that came with your monitor. 

m You may be using a graphics card that’s not compatible with your monitor. Contact the 
manufacturer of the graphics card for information.

Problems During System Restart and Wakeup From Sleep

You see the message, “This version of system software is not supported by the 
Apple Displays Software.”

m Make sure you’re using Mac OS 8 or later. 

m If this message appears in the Apple Displays Software Installer, make sure you select the 
startup hard disk in the Installation dialog box.

You see the message, “The AppleVision preferences are invalid and may have 
become corrupted.”

m Delete the AppleVision Preferences folder on your hard disk and restart your computer.

You see the message, “An error has occurred reading from or writing to a file.”

m Make sure you are not starting up from a non-writable disk, such as a CD, a locked hard 
drive, or a floppy disk.

You see the message, “This monitor is not supported by this version of the 
Apple Displays Software.”

m Make sure you have installed the Apple Displays Software that came with your monitor. 

You see the message, “AppleVision failed to load,” followed by an error code.

m If the Apple Displays Software is installed and you disable the Display Enabler extension, 
you can’t use the software. Make sure the Display Enabler extension is turned on in the 
Extensions Manager, then restart your computer.

m Restart your computer.

m Some viruses can cause problems with the Apple Displays Software. Make sure you 
regularly scan your computer for viruses.

m Reinstall the Apple Displays Software.

m Make sure your graphics card supports your monitor. Check with the manufacturer of 
your graphics card or computer. 
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You see the message, “The software needed to use the device ‘Studio Display’ 
cannot be found. Please refer to the device documentation to install the 
necessary software.”

m Make sure you’ve plugged in the monitor connector and USB connector properly. See 
“Connecting the Display to Your Computer” on page 10.

m Reinstall the Apple Displays Software.

ColorSync profiles are not updated when ColorSync software is installed.

Out-of-date profiles in the ColorSync Profiles folder are not removed automatically. If you 
want to remove a ColorSync profile, you must do so manually. See “Color Accuracy” in 
Mac OS Help (Mac OS 8.5) or in Monitors & Sound Help, available in the Help menu when 
the Monitors & Sound control panel is open (Mac OS 8 or 8.1).

Changes you make in the Monitors & Sound control panel don’t appear on the 
monitor.

m Make sure you have installed the software that came with your monitor.

m Because each monitor connected to your computer has its own Monitors & Sound 
window, use the window that displays the name of your monitor in the titlebar.

When you open the Monitors & Sound control panel, some resolutions are 
missing or only one resolution is available.

m Make sure you have connected the USB connector to a USB port on your computer. You 
cannot use many of the features of the Apple Displays Software without the USB 
connection. See “Connecting the Display to Your Computer” on page 10. 

m If the Apple Displays Software is installed and you disable the Display Enabler extension, 
you can’t use the software. Make sure the Display Enabler extension is turned on in the 
Extensions Manager, then restart your computer.

m Reinstall the Apple Displays Software.
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Getting Information and Updated Apple Software

Apple technical support information and software updates are available from online services. 
You can get troubleshooting and other important information by using these services. You 
can also get the latest versions of Apple software, including most printer drivers, system 
enablers, and updates to utilities and networking and communications software. 

Support information and Apple software updates are available via Apple’s World Wide Web 
site:

m http://www.info.apple.com

Where to get more information

When you have questions about using your monitor, there are several places where you can get 
more information.

This Booklet

Use this booklet to set up your monitor, install the Apple Displays Software, 
and find solutions to common problems.

About Your Studio Display

Use this online document to get more information about how to use your 
monitor with the Apple Displays Software. You can also get technical 
specifications and important health, safety, and maintenance tips for your 
monitor. 

Mac OS Help and Monitors & Sound Help

If you need help or experience a problem while using the Apple Displays 
Software, look in the Help menu. The Help menu is the main source for 
information about the Apple Displays Software and your Mac OS–based 
computer.


